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Overview 

Stellar Office 365 Extractor extracts mailbox data from office 365 account. It allows you to preview 
mailbox items directly by entering login credentials. The software also provides you with the ease of 
saving mailbox data into PST, MSG, EML, HTML, RTF and PDF formats. 

What's new in this version? 

 Support for MS Outlook 2016 

Key Features: 

 Option to connect with Office 365 account and extract mailbox. 

 Option to preview mailbox items. 

 Option to save mailbox data in PST, MSG, EML, HTML, RTF and PDF formats. 

 Option to save individual folders of mailbox (including sub folders) in PST, MSG, EML, HTML, RTF 

and PDF format. 

 Option to save an individual mail in MSG,EML,HTML,RTF and PDF format. 

  



Installation Procedure 

Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements 

 Processor: Pentium Class 

 Operating System: Windows10 / Windows 8.1 / Windows 8 / Windows 7 / Windows Vista / 

 Windows Server 12 / Windows Server 8 (R2) 

 Memory: Minimum 1 GB 

 Hard Disk: 50 MB of Free Space 

 MS Outlook: 2016, 2013, 2010 (with Service Pack 2) 

Steps to install Stellar Office 365 Extractor 

 Double-click StellarOffice365Extractor.exe executable file to start installation. Setup- Stellar 

Office 365 Extractor dialog box is displayed.  

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

 Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

 After completing the process, Completing the Stellar Office 365 Extractor Setup Wizard window 

is displayed. Click Finish. 

Note: Clear Launch Stellar Office 365 Extractor check box before clicking Finish to prevent the software 

from launching.  

 



Launching the Software 

To launch Stellar Office 365 Extractor in Windows 10: 

 Click Start icon -> All apps -> Stellar Office 365 Extractor  -> Stellar Office 365 Extractor  Or, 

 Double click Stellar Office 365 Extractor icon on the desktop. Or, 

 Click Stellar Office 365 Extractor tile on the home screen. 

 

To launch Stellar Office 365 Extractor in Windows  8.1 / 8: 

 Click Stellar Office 365 Extractor tile on the home screen. Or, 

 Double click Stellar Office 365 Extractor icon on the desktop. 

 

To launch Stellar Office 365 Extractor in Windows 7 / Vista: 

 Click Start -> Programs -> Stellar Office 365 Extractor -> Stellar Office 365 Extractor. Or, 

 Double click Stellar Office 365 Extractor icon on the desktop. Or, 

 Click Stellar Office 365 Extractor icon in Quick Launch. 



User Interface 

Stellar Office 365 Extractor software has a very easy to use Graphical User Interface. The user 

interface contains features required for extraction. 

After launching the software, you will see the main user interface as shown below. 

The user interface contains Menus and Buttons that let you access various features of the software with 

ease. 

 

   



Menus 

File Menu 

 

Connect to Office 365 
 
Use this option to connect to Office 365 account. 

Save 

Use this option to save the extracted data. 

Stop 

Use this option to stop the currently running 

process. 

Update Wizard 

Use this option to check for both, latest minor 

and major versions available online. 

Logs Menu 

 

Log Report 

Use this option to view / save the log report. 

Registration Menu 

 

Register 

Use this option to register the software after 

purchasing. 

Transfer License 

Use this option to transfer the license of the 



registered software to another computer. 

 

Help Menu 

 

Help 

Use this option to view the help manual for the 

software. 

Order 

Use this option to buy Stellar Office 365 

Extractor software. 

Support 

Use this option to view the support page of 

stellarinfo.com 

Knowledgebase 

Use this option to visit Knowledgebase articles of 

stellarinfo.com 

Enquiry 

Use this option to submit enquiry to 

stellarinfo.com 

About 

Use this option to read  information about the 

software. 

 
Application Menu 

 

https://www.stellarinfo.com/email-tools/office-365-to-outlook/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 

Connect to Office 365 
 
Use this option to connect to Office 365 account. 

Save 

Use this option to save the extracted data. 

Exit 

Use this option to exit application. 

 
 Customize Quick Access Toolbar Menu 

 

 
 
 
 
 

 

More commands 

Use this option to add a command to toolbar for 

quick access. 

Show Below the Ribbon 

Use this option to move down the Customize 

Quick Access Toolbar. 

Show Above the Ribbon 

Use this option to move the Customize Quick 

Access Toolbar to upper left area of application 

(default location). 

Minimize the Ribbon 

Use this option to minimize the ribbon. 

 
 

Style Menu 

 



 

Style 

Use this option to switch between various themes 

for the software, as per your choice. 

 
 

  



Buttons 

 

 

Click this button to connect to Office 365 account. 

 

 

Click this button to save mailbox data in PST, MSG, EML, HTML, RTF and PDF format. 

 

 

Click this button to stop the extraction process. 

 

 

 

Click this button to check for both, latest minor and major versions available online. 

 

 

 

Click this button to view / save the log report. 

 

 

Click this button to register the software after purchasing. 

 

 

Click this button to transfer the license of the registered software to another computer. 

 

 

Click this button to view the help manual for the software. 

 

 

Click this button to buy Stellar Office 365 Extractor software. 



 

 

Click this button to view the support page of stellarinfo.com. 

 

 

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

 

Click this button to submit enquiry to stellarinfo.com. 

 

 

Click this button to read  information about the software. 

  



Ordering the Software 

Click https://www.stellarinfo.com/email-tools/office-365-to-outlook.php to know more about Stellar Office 

365 Extractor. 

To purchase the software online, please visit https://www.stellarinfo.com/email-tools/office-365-to-

outlook/buy-now.php 

Alternatively, click Purchase Stellar Office 365 Extractor in Help Menu on Menu Bar to purchase the 

software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to activate the software. 
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Registering the Software 

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar Office 365 Extractor software. 

2. On Registration menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Registration window, type the Registration Key and click Register button (Please 

ensure that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for 

any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 

2. An Online Registration dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 



 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an 

Internet connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. An Offline Registration dialog box will appear displaying Registration ID in its 

respective field. 



 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar Office 365 Extractor. In Register window, 

select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key 

is entered. Click OK. 
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Transfer License 

Stellar Office 365 Extractor allows you to transfer the license of the registered software to another 
computer on which you want to run the software with full functionality. This operation deactivates the 
product on your current computer so it can be reactivated on the new computer.  

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer:  

1. Run demo version of the software. 

2. In Registration Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

On Source Computer: 

1. Run registered version of Stellar Office 365 Extractor software. 

2. In Registration Menu on Menu Bar, click Transfer License. 

 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 



4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save to File button 
to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 
location where you want to save the details. Click OK. 

6. 'License Key has been saved successfully' message is displayed after the saving process is 
completed successfully. Click OK. 

 

This will deactivate the product on Source Computer and you will no longer be able to use the software 
anymore on this computer. 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 

 

2. Click Register to complete the activation process.  

3. 'Activation Completed Successfully' message is displayed after the process is completed 
successfully. Click OK. 

 

 



Updating the Software 

Stellar releases periodical software updates for Stellar Office 365 Extractor software. You can update 

the software to keep it up-to-date. These updates can add a new functionality, feature, service, or any 

other information that can improve the software. Update option of the application is capable of checking 

for latest updates. This will check for both latest minor and major versions available online. You can easily 

download minor version through the update wizard. However, the major version, if available, has to be 

purchased. While updating the software, it’s recommended to close all the running programs. Note that 

demo version of the software cannot be updated. 

To update Stellar Office 365 Extractor: 

 Click Update Wizard icon from File Menu. 

 Stellar Update Wizard window opens. Click Next. The wizard will search for latest updates, and if 

it finds any new updates, a window will pop up indicating its availability. 

 Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

 Internet connection failure 

 Updates are not available 

Note: If a major version is available, you need to purchase the software in order to upgrade it.  

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 
 
You can either Call Us or Go Online to our support section at http://stellarinfo.com/support/ 

For price details and to place an order, click https://www.stellarinfo.com/email-tools/office-365-to-

outlook/buy-now.php 

Chat Live with an Online Technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/ 

Submit Enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders    orders@stellarinfo.com 

  

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-tools/office-365-to-outlook/buy-now.php
https://www.stellarinfo.com/email-tools/office-365-to-outlook/buy-now.php
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Connect to Office 365 Account 

Stellar Office 365 Extractor enables you to connect with office 365 mailbox account by simply entering 
login credentials. 

To get connected with office 365 account 

1. Run Stellar Office 365 Extractor. 
2. Stellar Office 365 Extractor dialog box opens. 

Or, 

Click Connect to Office 365 icon from File Menu to open Stellar Office 365 Extractor dialog box. 
Or, 

Click Connect to Office 365 icon from Application Menu to open Stellar Office 365 Extractor 
dialog box. 
Or, 

Double click Connect to Office 365 from left pane of application. 
3. Enter Email ID and Password in Office 365 Login. Click OK to continue. 

 

 

 

4. Stellar Office 365 Extractor will start connecting to the Office 365 account and once the connection is 

established, entire mailbox data will be listed in a tree view in left pane of application. 

5. You can preview mailbox items by clicking on the desired folder.  

  



Preview Mailbox Items  

Once Stellar Office 365 Extractor establishes a connection with Office 365, a window displays mailbox 

and its items. 

Left pane displays selected mailbox under Root node in a tree like structure while the Middle pane 
displays the list of mails. Click on any mail in the middle pane to see it's content, which is displayed in 
right pane as shown below.

 

  



Extract & Save Data 

Stellar Office 365 Extractor allows you to save the extracted data in various formats like PST, MSG, EML, 

HTML, RTF and PDF. 

To save the extracted data:  

 Click Save from File Menu or Application Menu. 

 Select the required format and then select the destination where you want to save the file. Click 

OK. 

 

Using Stellar Office 365 Extractor, you can save individual folder from mailbox in either of the given 

formats. 

To save extracted items, simply right-click on desired folder and: 

 Select Save as PST to save the mailbox in PST format. 

 Select Save as MSG to save the mailbox in MSG format. 

 Select Save as EML to save the mailbox in EML format. 

 Select Save as HTML to save the mailbox in HTML format. (Attachments cannot be saved, 

however, their names are visible) 

 Select Save as RTF to save the mailbox in RTF format. (Attachments cannot be saved, however, 

their names are visible)  

 Select Save as PDF to save the mailbox in PDF format. (CC of the mails is not shown and 

attachments cannot be saved, however, their names are visible). 



 

To save an individual mail, simply right-click on desired mail and: 

 Select Save as MSG to save the mail in MSG format. 

 Select Save as EML to save the mail in EML format. 

 Select Save as HTML to save the mail in HTML format. (Attachments cannot be saved, however, 

their names are visible) 

 Select Save as RTF to save the mail in RTF format. (Attachments cannot be saved, however, their 

names are visible)  

 Select Save as PDF to save the mail in PDF format. (CC of the mails is not shown and 

attachments cannot be saved, however, their names are visible). 



 

Note: You can save an individual mail in all provided formats except PST.  

Note: To save mailbox data in PST, MSG, EML, HTML, RTF and PDF format you need to install office 

2016 / 2013 / 2010 (with Service Pack 2). 

  



Save Log Report 

With Stellar Office 365 Extractor, you can save the Log Report to analyze the connection status at a 
later stage.  

To save the log report 

 Select Log Report from Logs menu. 

 A Log Report dialog box appears. click Save Log button to save the status (connected / 

disconnected). 

 

 In Save As dialog box, specify the location where you want to save the log file. Click Save. 

  



FAQs 

1. What does the demo version of the software do? 
 
Using demo version of the software you can only preview your mailbox data but cannot save it. To 
save your mailbox data you need to purchase and register Stellar Office 365 Extractor. 
 

2. Can I connect with multiple Microsoft Office 365 account at a single instance? 
 

Stellar Office 365 Extractor allows you to connect only with one Microsoft Office 365 account at a 
single instance. 

 
3. Why do I require to extract my Microsoft Office 365 data? 

 
Microsoft Office 365 account needs an online connectivity to access your data. But once an 
connection is established using Stellar Office 365 Extractor, you can extract your mailbox data and 
access it offline. 

 
4. I am unable to access my ongoing data when Stellar Office 365 Extractor is in succession?  

 
The application only extracts mailbox data of your Microsoft Office 365 account which was 
synchronized successfully before the connection got established. 

 
5. Can I save selective mail or folder from my office 365 mailbox? 

 
Yes, the application allows you to save data selectively. Users can:  
 

 Take complete backup of Microsoft Office 365 account. 

 Save data of individual folder (including sub-folders). 

 Extract & save an individual mail. 
 
6.  In which formats can i save my extracted data? 

 
You can save your extracted files in various formats like PST, MSG, EML, HTML, RTF and PDF. 

 

7. Is the process of extracting and saving Microsoft Office 365 data is similar for server and 
local machine? 

 
Yes, the process of extracting and saving Microsoft Office 365 data is same for both server & local 
machine. After establishing the connection, you can start the process of extraction and conversion. 
To know how to connect to mailbox, see Connect to Office 365 Account. 

8. I want to extract my Calendars and Contacts, how do I extract them using Stellar Office 365 

Extractor tool? 

First you need to extract and save the mailbox into PST file using the software. Then, import the PST 
file in Outlook and check your calendars and contacts. 

  



Legal Notices 

Copyright 

Stellar Office 365 Extractor software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 

user manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright© Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Office 365 Extractor® is a registered trademark of Stellar Information Technology Private Limited 

Windows Vista®, Windows 7®, Windows 8®, Windows 8.1®, Windows 10®, Windows server 12®, 

Windows server 8(R2)® are registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 



License Agreement 

Stellar Office 365 Extractor 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Office 365 Extractor. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Office 365 Extractor with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Office 365 Extractor. For purposes of this License, if you have a valid single-user license, you 

have the right to use a single Licensed Copy of Stellar Office 365 Extractor. If you or your organization 

has a valid multi-user license, then you or your organization has the right to use up to a number of 

Licensed Copies of Stellar Office 365 Extractor equal to the number of copies indicated in the 

documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Office 365 Extractor may either be used by a single person or used non-

simultaneously by multiple people who use the software personally installed on a single workstation. This 

is not a concurrent use license. 

All rights of any kind in Stellar Office 365 Extractor, which are not expressly granted in this license, are 

entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You shall not 

rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works based 

on Stellar Office 365 Extractor nor permit anyone else to do so. You shall not make access to Stellar 

Office 365 Extractor available to others in connection with a service bureau, application service provider 

or similar business nor permit anyone else to do so. 

https://www.stellarinfo.com/


Warranty Disclaimers and Liability Limitations 

Stellar Office 365 Extractor and all accompanying software, files, data and materials are distributed and 

provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge that 

good data processing procedure dictates that any program including Stellar Office 365 Extractor must 

be thoroughly tested with non-critical data before there is any reliance on it and you hereby assume the 

entire risk of all use of the copies of Stellar Office 365 Extractor covered by this License. This disclaimer 

of warranty constitutes an essential part of this License. In addition, in no event does Stellar authorize you 

or anyone else to use Stellar Office 365 Extractor in applications or systems where its failure to perform 

can reasonably be expected to result in a significant physical injury or in loss of life. Any such use is 

entirely at your own risk and you would not hold Stellar responsible for any and all claims or losses 

relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

Data Erasure 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently 

erase confidential data beyond the scope of data recovery.  You can perform high speed bulk data 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/file-repair/file-repair-software.php
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/prevent-dataloss.htm


erasure & generate erasure certificates for audit trail purpose. BitRaser supports 24 International data 

erasure standards. More Info >> 

For more information about us, please visit www.stellarinfo.com 

http://www.stellarinfo.com/data-erasure/data-eraser-windows.php
http://www.stellarinfo.com/

